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SST Super Show and Tell
With SST, you create a presentation based on the concept of a slide carousel.    Each new 
visual in the presentation is a slide.    A group of slides form the presentation or slide 
carousel.    Each slide has a background image or color.    A slide can be enhanced with the 
addition of media elements, like text, graphics, images, sounds or movies.    A variety of 
attributes    and/or actions    can be    assigned to each media element.    

For a detailed description and basic techniques relating to Carousels or Slides, click on the 
appropriate term.



Basic Design Concepts
At the core of the SST design is a simple concept, familiar to all presenters.    SST 
presentations are built around the concept of the slide carousel.    One SST presentation or a 
module of a large presentation is created in a carousel, just like the slide carousel still used 
in traditional slide presentations.    Individual SST slides are created to fill the carousel.    

Unlike a traditional slide, SST slides can include several different types of media or slide 
elements.    SST slide elements can be images, graphics, text, sound or movies.      A variety 
of attributes and actions can be assigned to each media element used in a slide.      

Attributes are used to define specific qualities of the media element.    An attribute choice for
draw media is the shape (e.g. line, rectangle or ellipse).    Likewise, font style is an example 
of a text attribute.      

Element actions are defined so that an element will take an action as the slide plays.    For 
example, a graphic element can move or change shape, size or color; a sound or movie 
element can be played; and a text element can scroll across the screen.    These are all 
examples of element actions.    

To review, the terms carousel and slide are used to simplify the organization of your 
presentation.    Carousels can contain an entire presentation or can be linked together to 
form larger presentations.    Slides are used to create a carousel and are made up of slide 
elements.    Slide elements have attributes and can have actions as the slide plays.



Slide Creation - MAAPPing a Slide
A slide can be composed of only a background color, gradient blend, image or sound or it 
may include a variety of media elements.    A presentation consisting of a group of slides 
with only background color, images or sound will resemble a traditional slide show.    What 
makes SST presentations dynamic is the ability to add a variety of other media elements to 
a slide and to assign actions to those elements.    

To create a typical slide, you will: 

1. Add new M  edia   elements.
2. Modify or define the elements by assigning A  ttributes   to them.    
3. Select A  ctions   for the media.    
4. Time and synchronize these actions on the action P  laylist  .
5. Move through and play the carousel using the P  lay Controls  . 

This process is referred to as MAAPPing a slide, an acronym created from the underlined 
letters shown in the steps above.    The MAAPP process is the key to creating multimedia 
presentations with SST.



Media
Using an appropriate blend of media types is what makes multimedia presentations 
impressive.    To add media to a slide in SST, simply click on the Media  icon.    A list of
five types of media is presented:    text, image, sound, draw or movie.

Click on one of the media choices to add an element of that media type to the slide. For 
example, if you click on Media, then click on Draw; a graphic shape is added to the slide 
and is visible in the Preview Window.    

When you select one of these media types, three things happen.
1.    An element of the selected type is added to the current slide.
2. A description of the element is placed in the Slide Element List.    This list box is just right 

of the Media icon.    
3. The Media Editor is changed to the appropriate editor for the tool selected.    The Media 

Editor is the quarter screen area occupying the center left of the screen.    



Attributes
After a media element is added to a slide, it can be assigned attributes (distinguishing 
qualities).    The Attributes list box is located at the top of the Media Editor, which 
occupies the left center screen. The contents of the Attributes list box vary according to 
the type of media selected in the Preview Window.

To select and assign an attribute, first click on the Attributes list box to drop down the list 
of attribute choices for the selected media type.    When a choice is made from the list, the 
lower part of the Media Editor changes to provide specific attribute choices.    For example, 
if a draw element is selected and you choose the Shape attribute, several shape choices are
shown.    If you choose Fill Color, a color selection chart is presented. 

When an attribute choice is made in the Media Editor, the selected element in the 
Preview Window immediately illustrates that change.

For details on the different attribute choices, click on one of the following media types:    
text, images, draw, sound or movies.



Actions
Actions are changes in attributes over time - as the slide plays. 

To assign an action to a slide or slide element:
1. First select the element to be modified.

2. Click on the Action icon  or right click on the element to bring up a list of actions 
which can be assigned for the current media type.

3. Click on an item in the list to select it.

When an action is added, a description of that action will automatically be added to the 
Playlist.    A default time for each action is assigned.    Click anywhere outside the list of 
choices to remove the list without adding an action.

Available actions differ depending on which type of media was selected.    Click on one of the
following media types for a description of the available actions:    Text, Image, Sound, Draw 
or Movie elements.    Two actions are available in all action lists:    Pause and Auto Record.   

The Pause action is used to adjust timing, by inserting a pause in the Playlist.    You can set 
the pause to wait for input, for a specific period of time or a combination of both.    Wait for 
input means to pause until a specific key or mouse button is pressed.    Click here to see the 
Pause Editor.      

Auto Record turns on the automatic recording mode when adding actions.    This mode 
streamlines the operation of defining a series of    actions.    When Auto Record is on any 
changes made to the attributes of the slide or element will be recorded as a new action.    
This process is much faster than clicking on the Action icon to add each action separately.

When Auto Record is on, the Action icon will flash.    To exit the Auto Record mode, 
simply click on the Action icon or from the Carousel menu, click on Auto Record to 
deselect it.

 



Playlist
Every slide has its own Playlist which is automatically generated each time an action is 
added to a slide.    Once added, actions are timed and synchronized directly on the Playlist.

The Expand icon  is used to open or close the Playlist.

Each action line in the playlist begins with a Synchronize icon, which consists of two 
triangles placed side by side horizontally or vertically.    This icon is used to synchronize or 
separate actions.    Clicking on the icon will toggle it from a horizontal to a vertical position 
and vice versa.    

The vertical (default) position  indicates that the action is to take place only after the 
preceding action ends.    The horizontal position 

 is the synchronize position.    This indicates that the action should begin to play at the 
same time as any adjacent action also in the synchronize position.    This feature is often 
used to synchronize sound with movement of objects or images.

When actions are defined, a default time is inserted in the Playlist just after the definition of 
the action.    The action will occur over that time period.    To edit the time setting directly on 
the line in the Playlist, simply position the mouse cursor over the numbers indicating time.    
When the mouse cursor changes to an I-beam shape, swipe across the numbers to highlight 
them, then enter the new time.    

On the far right side of an open action Playlist, there are controls used to move through the
Playlist quickly.    The double arrows pointing up are used to move to the first action in the 
list.    The single arrow up is used to move up five actions at a time.    The Expand icon (in 
the middle) is used to open or close the playlist.    Use the single arrow down to move down 
five actions and the double arrow down to move to the last action.



Play Controls
The slide can be played or viewed using the Play Controls.    You can click on the Rewind 
icon to move to the beginning of the Playlist.    Then click on the Play icon to see the slide in 
action.    

Play Controls are also used to move forward or backward through the carousel, add new 
slides, or step forward or backward through actions on each slide.    Click on any of the icons 
in the illustration below to see an explanation of that icon.



First Slide Icon
Click on the First Slide icon to move to the first slide of the current carousel.



Previous Slide Icon
Click on the Previous Slide icon to move to the slide which precedes the current slide 
in the carousel.    



Previous Action Icon
Click on this icon to move backward one action on the current slide.    In other words - 
to step back one line on the action playlist.



Rewind Icon
Click on this icon to move to the first action on the slide (to the beginning of the 
action playlist).    



Stop Icon
Click on this icon to immediately stop playback of the actions on the slide.



Play Icon
Click on this icon to begin playing the actions on the current slide.    The playback will 
begin from the current action.    To see all actions on the slide, click on the Rewind 
icon first and then click on the Play icon.



Next Action Icon
Click on this icon to move to the next action on the current slide (down one action on 
the action playlist).



Next Slide Icon
Click on this icon to move forward one slide in the current carousel.



Last Slide Icon
Click on this icon to move directly to the last slide in the current carousel.



Basic Techniques
The following Help Topics are available:

 An Overview
 Quick Help
 Basic Techniques
 Carousel
 Slides
 Media
 Menu Bar Commands
 Tutorials
 Troubleshooting

For Help on Help, Press F1



Menu Bar Commands
The following Help Topics are available:

 An Overview
 Quick Help
 Basic Techniques
 Menu Bar Commands
 File Menu Commands
 Edit Menu Commands
 Carousel Menu Commands
 View Menu Commands
 Run Menu Commands
 Window Menu Commands
 Tools Menu Commands
 Help Menu Commands
 Tutorials
 Troubleshooting

For Help on Help, Press F1



Troubleshooting
 An Overview
 Quick Help
 Basic Techniques
 Menu Bar Commands
 Tutorials
 Troubleshooting
    General Troubleshooting
    Audio Problems
    Image Display Questions
    Error Messages
    Technical Support

 





File Menu Commands
 Menu Bar Commands
 File Menu

Use To
New Start a new carousel.

Open Open an existing carousel file.

Close Close the current carousel.

Save Save changes made to the current carousel.

Save As Save changes made to the current carousel under a new name.

Save All Save the contents of all open carousels.      Click on the Window 
menu to see a list of    all open carousels.

Autosave Toggle the autosave feature on or off.    When Autosave is selected, 
a backup file will automatically be created at regular intervals, as 
defined in the User Preferences under the Edit menu.    The 
backup file will be named filename.bak, where filename is the 
name of the SST file being saved.

Save Slides Save a group of slides from this carousel as a file.    Enter a new 
filename in the Save As dialog box.    Then from the Select Slide 
Range To Copy dialog box, click on Set Start Slide to choose the 
first slide in the group to be copied.    Click on Set End Slide and 
choose the last slide.    Choose OK to exit or Cancel to exit without 
saving the information. 

Load Slides Load a group of slides into this carousel.

Printer Setup Set the printer options.

Print Handouts Print handouts of the screen display.

Print Playlist Print information about the open carousel, including an illustration 
of each slide and the contents of its playlist.

Create Pres. Disk Create a diskette for distribution of your carousel.    
 Click on Create Presentation Disk for detailed information.

Quit Exit SST.

Filename Open one of the most recently accessed carousels.

 Edit Menu Commands
 Carousel Menu Commands
 View Menu Commands



 Run Menu Commands
 Window Menu Commands
 Tools Menu Commands
 Help Menu Commands
 Tutorials



Edit Menu Commands
 Menu Bar Commands
 File Menu Commands
 Edit Menu Commands

Use To
Undo Delete Undo the most recent deletion on the current slide and restore that 

element or slide.

Undo Slide DeleteUndo a slide deletion and restore slide to carousel.

Clipboard Set the edit mode to Clipboard.    In this mode, the contents of 
elements or slides are transferred using the Windows clipboard.    
This mode can be used to share data with other Windows 
applications. See notes.

Scrap Buffer Set the edit mode to Scrap Buffer.    In this mode, the element or 
slide itself will be edited using an SST buffer.    All attributes of the 
element or slide are included in SST buffer information.    For 
example, if a text element is selected all text attributes (font style 
and size, location on the screen, color, etc.) are included. See 
notes.

The function of the following edit choices varies depending on whether Clipboard or Scrap 
Buffer is selected.    Each choice will be defined accordingly.

Use To
Cut If Clipboard is selected:

Remove the contents of the element and place it on the Windows 
clipboard.    

If Scrap Buffer is selected:
Remove the element or slide itself, including all attributes and 
place it in the Scrap Buffer.

Copy If Clipboard is selected:
Copy the contents of the highlighted element to the clipboard.    
Text must be selected before it can be copied.

If Scrap Buffer is selected:
Copy the selected element or slide with its attributes to the Scrap 
Buffer.    The original remains on the slide.

Paste If Clipboard is selected:
Paste the contents of the clipboard into the highlighted element in 
the Preview Window.

If Scrap Buffer is selected:
Paste the contents of the Scrap Buffer onto the current slide.

Clear If Clipboard is selected:
Delete the contents of the current element or slide, without    



placing it on the Clipboard.    

If Scrap Buffer is selected:
Delete the element or slide, without placing it in the buffer.

Duplicate If either Clipboard or Scrap Buffer are selected:
Copy the highlighted element and insert it on the screen or copy 
the slide and insert it after the current slide.

Insert Blank Slide Insert a new slide at the current carousel location. 

User Preferences Define authoring preferences.    Options include: 
- the choice to play a sound when starting SST
- Grid Spacing (5-100)
- Autosave Time (1-30) 
- Playlist Time format (milliseconds or seconds). 

 Carousel Menu Commands
 View Menu Commands
 Run Menu Commands
 Window Menu Commands
 Tools Menu Commands
 Help Menu Commands
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Carousel Menu Commands
 Menu Bar Commands
 File Menu Commands
 Edit Menu Commands
 Carousel Menu Commands

Use To
Play Options... Set default keystrokes and modes for playing the carousel.    Click 

here for a complete description of available play options. 

Jump to Slide... Bring up a dialog box to select a slide and jump to that slide.    A 
thumbnail sketch of each slide is presented as it is highlighted to 
ensure that the correct slide is being selected.

Auto Record Change to the automatic recording mode for assigning actions.    If a
check appears in front of this option, automatic recording is active.  
Click on Auto Record again to remove the check.

Presentation Size See information on the length of time and how much space the 
presentation and each individual slide in it requires.

 View Menu Commands
 Run Menu Commands
 Window Menu Commands
 Tools Menu Commands
 Help Menu Commands
 Tutorials



View Menu Commands
 Menu Bar Commands
 File Menu Commands
 Edit Menu Commands
 Carousel Menu Commands
 View Menu Commands

Use To
Toolbar Buttons Toggle on or off the toolbar button display for file, edit and 

alignment tools.

Bring To Top Moves the selected element to the top layer or slide foreground so 
that it will cover any other elements which overlap it.

Bring Forward Move the selected element forward one layer or one position on the
slide.

Push Behind Move the selected element backward one layer or one position on 
the slide.

Push To Bottom Move the selected element behind all other media elements.

Alignment Present submenu with choices to Align Top, Align Left, Align Right, 
Align Bottom, Center Vertically or Center Horizontally.    These 
alignment choices can be applied to several selected elements or 
to only one as indicated below. Click on the Align Submenu Choices 
for an explanation of each choice.

Even Spacing Present submenu with choices to evenly space selected multiple 
elements in a Horizontal or Vertical direction.

Same Size Present submenu with choices to make selected multiple elements 
the same size in Width or Height as the last selected.

Grid Present a submenu with choices to turn a grid Off or place it on the 
Preview Window using Points or Lines.

 Run Menu Commands
 Window Menu Commands
 Tools Menu Commands
 Help Menu Commands
 Tutorials



Run Menu Commands
 Menu Bar Commands
 File Menu Commands
 Edit Menu Commands
 Carousel Menu Commands
View Menu Commands
Run Menu Commands

Use To
Run Play the carousel starting with the current slide.

Full screen Switch to the full screen mode when playing the carousel.

Play Single Slide Toggle this option on or off.    On plays a single slide.    Off plays the 
carousel from the current slide on.

 Window Menu Commands
 Tools Menu Commands
 Help Menu Commands
 Tutorials



Window Menu Commands
 Menu Bar Commands
 File Menu Commands
 Edit Menu Commands
 Carousel Menu Commands
View Menu Commands
 Run Menu Commands
 Window Menu Commands

Use To
Close All Close all open carousels.

Filename Select or make active the named carousel from a list of open 
carousels.    The current carousel is identified with a check mark.

 Tools Menu Commands
 Help Menu Commands
 Tutorials



Tools Menu Commands
 Menu Bar Commands
 File Menu Commands
 Edit Menu Commands
 Carousel Menu Commands
View Menu Commands
 Run Menu Commands
 Window Menu Commands
 Window Menu Commands
 Tools Menu Commands

Use To
Launch Chart Mod. Bring up a charting module used to create charts which then

can be exported into SST.    

 Help Menu Commands
 Tutorials



Help Menu Commands
 Menu Bar Commands
 File Menu Commands
 Edit Menu Commands
 Carousel Menu Commands
View Menu Commands
 Run Menu Commands
 Window Menu Commands
 Window Menu Commands
 Tools Menu Commands
 Help Menu Commands

Use To
Index See an index of all help choices.    Included in the help section is an 

overview of the screen and brief practice tutorials.

About SST See current SST version information.

 Tutorials



Clipboard Notes
Note:    The Clipboard mode is only available for Text and Image elements or the 
background slide image.    If the Scrap Buffer mode is selected, the slide and all types of 
media elements can be transferred and their attributes will be retained.



Align Submenu Choices
Use To
Align Top Align the selected element to the top of the screen OR

If multiple elements are selected, align all to the top edge of the 
last selected element (identified by solid pull squares).

Align Left Align the selected element to the left side of the screen OR

If multiple elements are selected, align all to the left edge of the 
last selected element.

Align Right Align the selected element to the right side of the screen OR

If multiple elements are selected, align all to the right edge of the 
last selected element.

Align Bottom Align the selected element to the bottom edge of the screen OR

If multiple elements are selected, align all to the bottom edge of 
the last selected element.

Center Vertically Center between top and bottom of the screen OR

If multiple elements are selected, align all with the vertical center 
of the last selected element.

Center Horiz. Center between the left and right sides OR

If multiple elements are selected, align all with the horizontal 
center of the last selected element.



Play Options
The Play Options are selected by clicking on the box or circle in front of each option.    
A check in the box or a filled circle indicates that the option is selected.    If the option 
is triggered by a mouse click or keystroke, a list box displays selection choices.    

For more information about the play options, click on that option in the illustration 
below.



Pause Presentation Key
Select Pause Presentation Key to select a key to be used to temporarily stop the 
presentation.    If the key is pressed the actions on the current slide will stop until the 
same key is pressed again to restart the presentation.    This allows a presenter to 
pause and respond to a question.



Exit Presentation Key
Click on Exit Presentation Key to select the key which can be used to interrupt and 
exit a presentation as it plays.



Jump To Slide Dialog
This selection allows you to choose a keystroke to be used to present the Jump to 
Slide dialog box on the screen as the presentation plays.    This allows the presenter 
to choose and spontaneously jump to another part of the presentation as it is being 
shown.



Mouse Button Actions
Choose Mouse Button Actions to select actions which will occur if the Left, Center or 
Right mouse button is clicked.    Mouse button actions are often used to allow the 
presenter to move forward or back one slide in the carousel when the mouse button 
is clicked.



Unload Slides When Played 
Place a check in front of this option to unload slides after they play.    This option is 
used to free memory.



Disable Auto-Blacking
Place a check in front of this option to remove the auto-blacking between slides.    
Auto-blacking occurs by default whenever showing a slide with a different palette.    
This prevents the flash of color otherwise seen during these transitions.        



Select and Use Master Slide
Click on this option to bring up a dialog box for selecting a slide to be used as a 
master slide.    When a master slides is selected, all slides added or inserted will be 
duplicates of the master, including slide attributes, media elements and actions.    The
master slide can be changed or removed at any time.



Carousel Presentation Modes
The Carousel Presentation Modes option provides two choices:    Replay 
Carousel When Last Slide Finished and Play One Time and End.    Thus you can 
elect to continuously replay the carousel or stop after one playback.



Create Presentation Disk
SST allows you to create a runtime version of your carousel to be installed and played on 
other systems.    The runtime version will contain all files used in the carousel and all files 
needed by SST to run the carousel.    The time required for creating a runtime disk will vary 
according to the size of your carousel and the elements contained in it.    

From the File menu, click on Create Presentation Disk to bring up a dialog box as shown 
below used to set preferences for the runtime version.    

To create a runtime version of your carousel:
1. Click on Select to choose the drive and directory into which your runtime version will

be placed.    Your choice will appear in the box labeled: Target Directory.
2. Determine which options you will use (e.g. Lock Runtime Carousel).    Place a check

in the box in front of an option to select it.    
3. Click on Start to begin the process.
4.    Click on Stop to stop the process before it is complete.
5.    Click on Exit to remove this dialog box and return to SST.

For more information about some of the options available in this dialog box, click on the 
option in the illustration when the mouse cursor changes shape.

Note:    If you plan to distribute your presentation, we recommend that you use only 
standard Windows fonts, in case the end user does not have other fonts available.    Fonts 
are not included in the Runtime version, due to setup constraints.

Create Presentation Disk can also be used to create a backup of all the files used in a 



presentation.    Use a new directory for the backup files, then choose that directory as the 
target directory.    All media files used in the carousel will be placed in this directory. 



Process Status Bars
As the runtime version is being created two Process Status bars at the bottom of 
the dialog box present progress information.    The top bar illustrates the overall 
progress made in creating the runtime version, while the lower bar illustrates the 
status as each file used in the carousel is added.



Compress Presentation Files
Select this option to compress the files so that the runtime version will require less 
disk space (e.g. fewer diskettes to distribute). 

Note:  If the Compress feature is selected one large compressed file will be created.    
Using Compress Presentation Files will require more hard disk space on the target 
computer as the application is being installed.    The space required will be equal to the 
size of the compressed file plus the size of each expanded file used in the application.    
This feature also uses temporary work space on the hard drive which is established with 
the SET command in your AUTOEXEC.BAT file.    An example of this command line is:    
SETTEMP=C:\TEMP

If this option is selected you must select Create Windows Setup Files so that the 
compressed file can be decompressed properly.



Create Windows Setup Files
Select this option to include files necessary for creating a Windows setup routine.    
Setup is used to install your presentation on another system.    This option is selected 
by default.



Lock Runtime Carousel
Select this option to protect your carousel from being changed or edited.    If the 
carousel is not locked, anyone using SST can modify it.



Options
Select Options to bring up the Play Options dialog box.    This allows you to define 
presentation mode, mouse button actions and other carousel play option preferences.



Element Layers
Media elements are layered on the screen as they are added, with those elements on 
the top covering elements in lower "layers".    The Element List reflects the order of 
the elements on the slide.    To reorder elements, use one of the four layering controls 
found under the View menu: Bring To Top, Bring Forward, Push Behind, Bush To 
Bottom.

 





Carousel
Since a carousel is the presentation file itself, many of the options used to manipulate a 
carousel can be found under the File menu.    Carousels can be opened, closed, saved, 
printed or distributed using selections from the File menu. 

Though more than one carousel may be open at one time, only one is visible in the SST 
creation environment.    It is referred to as the current carousel and is identified in a box 
near the lower left corner of the creation environment.      

To play a carousel: 

1. Move to the beginning of the carousel using the First Slide icon  in the Play 
Controls.    Then move to the beginning of the slide, using the Rewind icon.

2. Double-click on the thumbnail sketch of the first slide to play the carousel.
-OR-
2. Click on the Play icon  in the Play Controls.    The slide will be presented full 
screen and will begin to play.    
-OR-
2. From the Run menu, choose Run. 

To stop playing a carousel:    
· Press ESC.    You will be returned to the SST environment.    ESC is the default key selection. 

Another choice can be made by modifying the Play Options under the Carousel menu 
for Exit Presentation Key.    

You can play the current slide only or the entire carousel.    Under View, the option to Play 
Single Slide allows you to make that choice.    To play only the current slide, place a check 
by Play Single Slide.    

For more information on any of the following techniques, click on the highlighted area.

To open an existing or create a new carousel.
To save a carousel.
To close a carousel.
To link carousels together.
To distribute a carousel, use Create Presentation Disk from the File menu.
To move to a new slide in a carousel.
To print a carousel or carousel information.
To check carousel information (size, play options).



Open or Create Carousel
To create a new carousel - from the File menu, choose New.

To open an existing carousel - from the File menu, choose Open.

To bring up a different already open carousel - from the Window menu, choose the 
carousel filename.



Save Carousel
To save a carousel - from the File menu, choose Save.

To save a carousel under a new name - from the File menu, choose Save As.

To save several open carousels - from the File menu, choose Save All.

To backup file automatically - from the File menu, choose Autosave.



Close Carousel
To close the current carousel - from the File menu, choose Close.
 
-OR- 

To close all open carousels - from the Window menu, chose Close All.



Link Carousels
To link carousels together, designate a Hot Spot in one carousel with the option 
selected to branch to a specific slide in another carousel. 

-OR-

Under Slide attributes, choose Exit, then Select Next Carousel.



Move to a Different Slide
To move to a new position in the carousel, choose the appropriate icon from the Play 
Controls. 

-OR-

From the Carousel menu, choose Jump to Slide. 

-OR-

After clicking on the Sorter  icon, use the autoscroll technique.



Autoscroll Technique
To reorder slides using the autoscroll technique:
1. Click on the slide to be moved and drag it toward the direction indicated below:

Drag to this edge To scroll this direction
Top Backward in the carousel, one row of slides at a time
Right Forward one slide at a time
Left Backward one slide at a time
Bottom Forward one row of slide at a time

2. Drop the slide in its new position.



Print Carousel
To print slides - from the File menu, choose Print Handouts.    A dialog box will be 
displayed allowing you to choose to print the entire carousel, a single slide or group 
of slides.    

To print slides with their playlists - from the File menu, choose Print Playlist.    You 
may choose to print the entire carousel, a single slide or a group of slides.    A page is 
printed for each slide which has a view of the screen and the contents of the Playlist.



Check Carousel Information
To check presentation size - choose Presentation Size from the Carousel menu.    A
dialog box will be presented listing each slide and its size and a total size for the 
presentation.

To modify carousel playback options - choose Play Options from the Carousel menu.  
A dialog box is presented which offers several choices.



Slide
Slide Description
Slide Techniques
Slide Attributes
Slide Actions



Slide Description
Slides are grouped together to form carousels.    The slide itself can have attributes and can 
take on actions.    Other media is added to the slide as a slide element. 

The qualities or attributes which define a slide can be images, colors or sounds.    A very 
simple slide show type of presentation is created by simply assigning slide attributes to a 
series of slides.    However a typical SST slide is created by modifying slide attributes and by 
adding new media elements, which also have attributes.

Sound and images can be added to a slide either as media elements or as attributes of the 
slide.    The basic rule to remember is that images or sounds attached to the background 
slide itself cannot be manipulated (assigned actions) whereas sound or image media added 
as media elements can be assigned their own attributes or actions.    

The current slide is the one available for editing.    It is displayed in both the Preview 
Window and the center, framed thumbnail in the band of thumbnail sketches.    This allows 
you to view the current slide in relation to other slides in the carousel.    The current slide is 
identified in a box to the left of the thumbnail sketches.



Slide Techniques
A slide can be composed only of a background color, gradient blend, image or sound or it 
may include a variety of media elements.    A presentation consisting of a group of slides 
with only background color, images or sound will resemble a traditional slide show.    What 
makes SST presentations dynamic is the ability to add a variety of other media elements to 
a slide and to assign actions to those elements.    

Here are a few of the basic techniques used with slides.
To add a new slide:
· Click on the Slide Advance icon    (slide is inserted after current slide). 
-OR-
· From the Edit menu, select Insert Slide (slide is inserted in front of current slide).

To change slide attributes:    
1.    Click on the slide background or choose Slide from the Slide Element List to bring 

up the Slide Editor.    
2.    Click on the Attributes list box to see a list of attribute choices.

To move to a different slide: 
· Double-click on the thumbnail sketch of the slide to be selected.    It will be placed in the 

slide Preview Window.
-OR-
· Under Carousel, choose Jump to Slide and select the desired slide.    The Jump to 

Slide dialog box contains a list of slides.    As each slide on the list is highlighted a 
thumbnail sketch is shown to ensure that the correct slide is selected.

To create a typical slide, you will: 
1. Add new Media elements.
2. Modify or define the elements by assigning Attributes to it.    
3. Select Actions for the media.    
4. Time and synchronize these actions on the action Playlist.
5. Move through and play the carousel using the Play Controls. 

This process is referred to as MAAPPing a slide, an acronym created from the underlined 
letters shown in the steps above.    The MAAPP process is the key to creating presentations 
with SST.

To reorder slides in a carousel:    
· Position the mouse cursor on the slide to be moved, then drag and drop it on the new 

position.    The mouse cursor changes to a scissor shape.    This may be easier if you first 
click on the Sorter icon  to bring up a screen with a larger number of slides.

    



Slide Attributes
The Slide Editor is used to assign attributes to the slide itself.    Seven attributes can be 
assigned. Click on the Attributes list box to view the list of attribute choices for the 
background slide.
Image - Click on Image to place an image on the slide.    SST supports nine image file 

formats:    BMP, DIB, PCX, TIF, GIF, TGA, WMF, JPG or PCD.    When Image is selected, the 
Image Editor will be presented.

Sound - Click on Sound to associate a sound file with the slide itself.    SST supports both 
the WAV and MIDI formats.    When Sound is selected, the Sound Editor is displayed.

Background Color - Click on Background Color to assign a background color to the slide 
itself.    When Background Color is selected, the Slide Editor will display a group of 
colors.    Click on a color to select it.    The entire slide background will change to that 
color.

Foreground Color - Click on Foreground Color to assign a second color to be used in 
creating gradients.    When Foreground Color is selected, the Slide Editor will display 
a group of colors.    Click on a color to select it.    The background and foreground colors 
are blended in the style selected in the Gradient Style attribute below.    If the Solid 
style is selected, a Foreground Color will not be used.

Gradient Style - Click on Gradient Style to select a gradient style for the fill color(s).    The 
Gradient Style Editor will appear.

Entrance - Click on Entrance to define entrance options for the slide, such as transition 
effects and times.      When Entrance is selected, the Slide Entrance Editor will be 
displayed.

Exit - Click on Exit to define exit options for the slide.    When Exit is selected, the Slide Exit 
Editor will be displayed.



Image Editor     
· Use Load Image to bring up a File Selection dialog box.    Choose List Files of Type to 

select the appropriate file format.    Use Drives and Directories to locate the proper 
subdirectory, then double-click on the filename to select the file.    A Preview box is 
available in the File Selection box.    Click on Preview to see a thumbnail sketch of the 
highlighted image.

· Use Clear Image to remove the selected image from the image element so that a 
different image can be selected with the Load Image... option.

· Use Acquire Image to bring up the interface for the TWAIN device chosen in Select 
Source.    The interface presented will vary according to the device selected, but is used 
to create a new image.    For example if a scanner was the selected TWAIN device, the 
interface would probably have a preview window, options to set scan mode, resolution 
and size, as well as the option to create the new image.
When the image is created, save it as a bitmap.    Then use the Load Image option in 
this editor to add it to an SST presentation.      

· Use Select Source to choose the TWAIN device to be used when you select Acquire 
Image.    A list box is presented listing all TWAIN devices detected on your system.    
Select a device by double-clicking on it or by highlighting it and clicking Select.    Click 
Cancel to exit the selection box without choosing a device.

· Use Paste Image to paste the contents of the Windows clipboard as the image attribute.
· Use Save as Bitmap to convert the selected (non-BMP) file into the *.BMP format, which

displays more quickly in SST.
· Use Tile to place multiple copies of the image on the screen until the screen is filled (the 

wallpaper effect).
· Choose Use Images Palette to opt to use the palette saved with this file instead of 

using a default palette when displaying the image.    This produces a more accurate 
reproduction of the file on the screen.    On the other hand, if several images are being 
shown at one time, using the default palette may be a better option.

Note:    The Image attribute for a slide will always be positioned in the center of the screen. 
It cannot be repositioned or resized.    Because fewer calculations are required to display this 
type of image, it is an excellent choice to be used as a background for smoothly scrolling 
text or graphics.    When elements are scrolled across images which have been resized, the 
movement is less smooth.



Background Sound Editor

· Click on Select Sound to bring up a File Selection box.    Under List Files of Type, 
choose *.WAV for a digital audio file or *.MID for a MIDI file.    Double-click on the 
filename to be selected.    Click on the Preview box to listen to a sound before selecting 
it.

· Use Clear to remove the selected sound file from the sound element.

Note:    If a slide has a Sound attribute, the sound file will automatically begin to play when 
the slide is displayed.    Because it is not connected to a play action, it will continue to play 
as the actions on the Playlist occur.

The Sound attribute can be used to play a sound file over multiple slides.    Simply set the 
Show Slide time to less than the length of the sound file.    For example, if there are no other 
actions on the Playlist and Show Slide is set at for five seconds, a nine-second sound file 
will continue to play for four seconds as the next slide is shown.    In addition, under the Exit 
attribute, deselect the option to Exit When Slide Audio Complete.



Gradient Style Editor

· Click on the list box to choose a gradient style.    Available styles are:    Solid, Rectangle, 
Ellipse, Horizontal Bar, Vertical Bar, Star 1, Star 2, Star 3 and Diamond.    

· Choose the center point from which the gradient will blend outward by designating a 
pixel location or by adjusting the horizontal and vertical sliders.      

· Use Save As File to bring up a dialog box to name and save the gradient background as
a *.BMP file.    

· Select Use As Background if you wish to use the saved file as a background image on 
the current slide.



Slide Entrance Editor

· Use Slide Entrance Transition to choose a transition effect.    There are 33 possible 
entrance transitional effects.

· Use Duration to set the length of time over which the entrance will occur. 
· Use Stop Previous Slide Sound(s) to turn off or stop playing a sound file from 

previous slide if it is still playing.
· Use Slide Name to designate a name for this slide, instead of using the default slide 

number.    This is helpful in large carousels especially if you will be branching to the slide.



Entrance Transitions
·          Show Image shows the slide without any special effect.    This is the default 
entrance.
·          Horizontal Blinds presents the slide in horizontal bands across the screen, which 
increase in size until the slide fills the screen.    This creates the illusion of blinds being 
opened.
·         Vertical Blinds presents the slide in vertical bands across the screen, creating the 
illusion of vertical blinds.
·          Slide from (direction) slides the image onto the screen from the specified 
direction.    With a slide transition, the opposite edge of the slide appears first and 
gradually shifts into the correct position.    Slide transitions can occur from the Right, 
Left, Top, Bottom, Top Right, Top Left, Bottom Right or Bottom Left.
·          Reveal from (direction) reveals the slide from the specified direction.    This 
transition gives the appearance of simply uncovering the slide, instead of moving or 
sliding it on the screen.    Reveal transitions can occur from the Right, Left, Top, 
Bottom, Top Right, Top Left, Bottom Right, Bottom Left, Center or Edges.
·          Grow from (direction) increases the size of the slide until it fills the entire 
screen.    A small version of the slide first appears at the location defined by the direction.
Grow transitions can occur from the Right, Left, Top, Bottom, Top Right, Top Left, 
Bottom Right, Bottom Left or Center.
·          Double Blinds combines the horizontal and vertical blind transitions for a square 
fill effect.
·          Open Iris fills the screen beginning from a circle in the center and developing 
outward.    As the transition evolves, the circle gradually changes into the rectangular 
shape of the screen.
·          Star Burst fills the screen beginning with a star shape and developing outward 
until the entire screen is filled.



Slide Exit Editor

· Use Slide Exit Transition to choose a transition effect to be used to remove slide.    
There are 33 possible exit transition effects.

· Use Duration to set the time over which the exit transition will occur.    The default 
setting is 1000 milliseconds or one second.

· Use Select Next Slide to select the next slide if it is not the next slide in order in the 
carousel.    

· Use Select Next Carousel to select a new carousel to play when this slide has finished 
playing.

· Use Stop Sound(s) on Exit to stop all sound files from playing when the slide exits.
· Use Exit When Slide Time Elapsed to exit if the time set for the Show Slide action in 

the Playlist has elapsed.
· Use Exit When Slide Audio Complete to exit if all audio files have finished playing.    

Deselect this option to play a sound slide attribute over several slides.
· Use Exit Slide When All Actions Complete to exit only if all actions on the Playlist 

have finished playing.

Note:    If the last three exit conditions are not selected the slide will not exit until a Hot Spot
is clicked to branch to another slide.    Thus de-selecting the three exit conditions is often 
used to create a wait for user input.



Exit Transitions
·          Hold Image keeps the slide on screen until it is covered with the next slide in the 
carousel.    This is the default transition.
·          Horizontal Blinds removes the slide by covering it with black horizontal bands 
across the screen.    The bands increase in width until the entire slide is removed.    This 
transition creates the illusion of blinds closing. 
·          Vertical Blinds removes the slide by covering it with black vertical bands which 
increase in width until they fill the screen.
·          Slide to (direction) slides or shifts the slide off the screen in the specified 
direction.    Direction options are Right, Left, Top, Bottom, Top Right, Top Left, 
Bottom Right and Bottom Left.
·          Hide to (direction) hides or covers the slide in one of the following directions:    
Right, Left, Top, Bottom, Top Right, Bottom Right, Bottom Left, Center or Edges.
·         Shrink to (direction) shrinks or scales down the slide until it disappears from the 
screen.    The Shrink transition can occur to the Right, Left, Top, Bottom, Top Right, 
Top Left, Bottom Right, Bottom Left or Center.
·          Double Blinds removes the slide by covering it with vertical and horizontal black 
bars which increase in size until the slide is completely covered.
·          Close Iris removes the slide in a pattern which begins at the outside edges of the 
screen and moves inward.    As the transition evolves, the remaining slide is visible as a 
circular shape in the center of the screen before it disappears.
·          Star Burst removes the slide from the outside edges first and moves inward, 
leaving the slide visible in a star shape before disappearing from the screen.



Slide Actions 
There are three slide action choices.    To bring up a list of slide actions, click on the Action 
icon when the Slide Editor is being displayed.
Background Color Change - Select Background Color Change to change the background 

fill color of the slide to a new shade during the specified time.
Pause - Select Pause to insert a pause in the Playlist, in other words to pause before 

executing the next action for a set period of time or until a specified key or mouse button
is clicked.    Click here to see the Media Editor for Pause.

Auto Record - Choose Auto Record to turn on the automatic recording mode when adding 
actions.    This mode streamlines the operation of defining a series of actions.    When 
Auto Record is on any changes made to the attributes of the slide or element will be 
recorded as a new action.    
The Action icon will flash when the Auto Record mode is on.    Auto Record can be 
initiated by choosing this option from any Action list or by selecting the Auto Record 
option from the Carousel menu.    To exit Auto Record, click on the Action icon or from 
the Carousel menu, deselect Auto Record by clicking on it.



Pause

· Place a check by Wait for Input to set a pause until a specific mouse button or key 
stroke is pressed.    Select the appropriate key stroke or mouse button action from the list 
box below this selection.
· Place a check by Time Out to set a pause for a specific period of time.    Enter the 
amount of time in the box below this selection.



Media
 Quick Help
 Basic Techniques
    Carousel
    Slides
    Media
    Text
    Image
    Draw
    Sound
    Movie
    Menu bar Commands



Text
Text Description
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Text Actions



Text Description

Text is used to add titles, identify areas shown on the screen or provide written 
descriptions.    Text should never overwhelm the reader, but should be used to 
enhance the presentation by focusing the audience on the key points and helping to 
explain those points.      Avoid cluttering a slide with too much text, using too many 
text styles or colors or using all capital letters.    Text can be added to an SST 
presentation either by importing an ASCII text file (*.TXT) or by entering the text 
directly via the Text Editor.



Text Attributes
The Text Editor is used to assign attributes to text elements.    Ten text attributes are listed 
for text.
Text - Use Text to enter or edit the text string for the current text element.    Click on Import

Text to bring up a File Selection dialog box to select a text file to be imported.    Any 
ASCII file (*.TXT) can be imported into the Text Editor.

Font - Use Font to check or change the current font setting.    To change the font, click on 
Select Font to bring up a Font Selection dialog box.    Then choose a Font, Font Style 
(e.g. bold or italic) and point Size.

Alignment - Use Alignment to align the text string within the text bounding box to the 
Left, Right or Center of the bounding box.

Fill Color - Use Fill Color to set the color of the text itself.
Background Color - Use Background Color to set the color used to fill the area inside the 

text element bounding box excluding the text itself.    The background color is only visible
if the Background Mode is set to Opaque.      

Background Mode - Use Background Mode to set the background mode to Transparent 
(the default) or Opaque.    If the mode is Transparent, the Background Color attribute
has no effect.

Location / Size  - Use Location/Size to position element on slide using right, left, up and 
down arrows.      A Location/Size Editor will be displayed.

Frame Appearance - Use Frame Appearance to create a frame around the selected 
element.    Choices for frame appearance are made from the Frame Appearance Editor.

Text Appearance - Use Text Appearance to assign special text attributes.    If Text 
Appearance is selected the Text Appearance Editor is displayed.

Hot Spot - Use Hot Spot to define the area covered by the bounding box of this element as 
a hot spot for interactive branching or to trigger an event.    If Hot Spot is selected, the 
Hot Spot Editor is displayed.



Location/Size

The Media Editor is divided into four areas labeled Left, Top, Width and Height.    
· Clicking on the arrows in the Left or Top areas moves the selected object in the 

corresponding direction.    The edit box in the Left area gives the pixel location of the pull
squares on the left edge of the element.    The edit box in the Top area lists the pixel 
location of the pull squares on the top edge of the element.    

· Use the arrows in the Width or Height areas to resize the object.    The elements width 
in pixels is indicated in the Width edit box.    The height of the element is indicated in the
Height edit box.



Frame Appearance

· Use the Bevel Width list box to define the width in pixels of the beveled area of the 
frame.    

· Three Colors are used in the frame.    Light and Dark are each used for two sides of the 
frame to give it a three dimensional look.    Light is used for the upper and left sides, 
Dark defines the lower and right sides.    Face sets a fill color for the background of the 
bounding box of the text and irregular shape elements.

· Use Transparent Face to make the background of the bounding box around the 
element transparent (applicable to text and irregular shapes only).



Text Appearance

· Use Plain to present the text without any shadowing effects.
· Use Raised to create a raised text appearance with a black edge.
· Use Lowered to create a recessed text appearance with a white edge.
· Use Shadowed to create a text shadow. When Shadowed is selected, two choices on 

the right side of the media editor become available: Offset and Color.
·          Click on Offset to define a Horizontal and Vertical Offset in pixels.    Positive 
numbers are used to place the shadow to the right of and beneath the text.    Negative 
numbers are used to place the shadow to the left of and above the text. 
· Click on Color to bring up a color selection box to choose the shadow color.



Hot Spot

· Use Jump to slide in present Carousel to bring up a Jump to Slide dialog box.    
Thumbnail sketches of slides appear as each slide is highlighted on the list to ensure that 
the correct slide is being selected.    Double-click on the slide name to select it.    The slide 
will be identified in a box at the top of the editor.    If the image element is clicked as the 
presentation plays, the selected slide will be presented immediately.
· Use Jump to Carousel, starting slide o to bring up a File Selection box to select 
the name of a different carousel.    Double-click on the filename to select it.    The carousel is 
identified in a box at the top of the editor.    By default, the second carousel will begin playing
on the first slide.    A different beginning slide in the second carousel can be selected by 
editing the slide number which appears in the starting slide box.
· Use Perform Slide Exit to complete the display of this slide as defined by the Exit 
slide attribute before jumping to a new slide or carousel.    This option is only available if 
either the Jump to slide or Jump to Carousel option is checked.
· Use Play Sound to bring up a list of sound elements for the slide.    Double-click on the 

sound element to select it.    The sound will be played if the hot spot is triggered.
· Use Show Movie to bring up a list of movie elements for the slide.    Double-click on a 

movie element to select it.    Then the movie will begin to play if the hot spot is triggered.



Text Actions 
Text Actions are assigned to text elements, by clicking the Action icon while the element is 
highlighted.
Move / Size - Use Move/Size to move a text element to a new position on or off the slide or 

to resize the element.    After Move/Size is selected the element can be moved or 
resized using the arrows displayed in the Text Editor.    It can also be moved by dragging
it to a new location or resized by dragging one of the pull squares around the bounding 
box. 

Font Change - Use Font Change to change to a different font style.    This action cannot 
occur gradually, but is automatically set to occur over one millisecond.

Fill Color Change  - Use Fill Color to change the color of the text.
Text Alignment - Use Text Alignment to change the alignment of the text in the bounding 

box.    Choices are Left, Right or Center alignment.
Background Color Change - Use Background Color Change to change the color of the 

area inside the bounding box, excluding the text.    The option applies only if the 
Background Mode is Opaque.

Background Mode - Use Background Mode to change the background mode to 
Transparent or Opaque.

Shadow Change - Use Shadow Change to change the text appearance (e.g. plain, raised, 
lowered or shadowed effects).

Pause - Use Pause to add a pause in the Playlist which will occur before executing the next
action in the Playlist either for a set period of time or until a specified key or mouse 
button is pressed or both.    These choices are presented in the Pause Editor.

Auto Record - Use Auto Record to switch to the automatic recording mode. This mode 
streamlines the operation of defining a series of actions.    When Auto Record is on any 
changes made to the attributes of the slide or element will be recorded as a new action.   
The Action icon will flash when the Auto Record mode is on.    Auto Record can be 
initiated by choosing this option from any Action list or by selecting the Auto Record 
option from the Carousel menu.    To exit Auto Record, click on the Action icon or from 
the Carousel menu, deselect Auto Record by clicking on it.
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Image Description

Images add visual interest to any presentation.    Images can be scanned, drawn in 
a paint program, created in the chart module, selected from clip media or captured 
using a video capture card.    If your image creation tool (e.g. a scanner) has TWAIN 
drivers, images can be created directly from within SST.    

Regardless of the source of the image, if it has been saved in a file format supported 
by SST, it can be displayed in an SST presentation.    The supported file formats are:    
BMP, DIB, PCX, TIF, GIF, WMF, PCD, JPG or TGA.    Images can also be saved in a 
variety of resolutions.    A 24-bit (16.7 million colors) image, though impressive, 
requires more disk space and may not be supported on some systems.      Consider 
whether the presentation is to be distributed or shown on only one system before 
deciding what type and resolution of images will be included in your presentation.



Image Attributes
The Image Editor is used to select or modify image elements.    Five attributes can be 
selected from the Image Editor.    The ability to define attributes and actions for an image 
element is what makes it unique from an image used as a slide attribute.
Image - Use Image to select an image file (BMP, PCX, DIB, TIF, GIF, WMF, TGA, JPG or PCD 

format) for the image element.    The Image Editor which is displayed has options for 
selecting or creating an image.

Location / Size - Use Location/Size to position the element on the slide or to resize the 
element.    A Location/Size Editor will be displayed.    

Transparent Color - Use Transparent Color to choose a color from the image to be made 
transparent.    Place a check in front of Mask Color to make the color transparent.    This 
attribute is useful for an image which has an irregular shape drawn on a plain 
background, such as a company logo.    If the color of the background is transparent, only
the shape itself will show.    

Frame Appearance - Use Frame Appearance to create a frame around the selected 
element.    The Frame Appearance Editor will be presented if this attribute is selected.. 

Hot Spot - Use Hot Spot to define the area covered by this element as a hot spot for 
interactive branching or to trigger an event.    When the Hot Spot attribute is selected, 
the Hot Spot Editor will be presented.



Image Editor

· Use Load Image... to bring up the File Selection dialog box to select an image file.    
Open the List Files of Type list box to select the correct file format.    Use Drives and 
Directories to locate the subdirectory containing the file to be selected.    Click on Preview 
to see a thumbnail sketch of the image before selecting it.    Then double-click on the 
filename to select it.    
· Use Clear Image to remove the selected image from the element, so that a new 
image can be selected.
· Use Acquire Image to bring up the interface for the TWAIN device chosen in Select 
Source.    The interface presented will vary according to the device selected, but will allow 
you to create a new image using that device.    For example if a scanner was the selected 
TWAIN device, the interface would probably have a preview window, options to set scan 
mode, resolution and size and the option to create the new image.

When the image is created, save it as a bitmap.    Then use the Load Image option in 
this editor to add it to an SST presentation.      

· Use Select Source to choose the TWAIN device to be used when you select Acquire 
Image.    A list box is presented listing all TWAIN devices detected on your system.    
Select a device by double-clicking on it or by highlighting it and clicking on Select.    
Click Cancel to exit the selection box without choosing a device.

· Use Paste Image to paste the contents of the Windows clipboard into the image 
element.

· Use Save as Bitmap to convert the selected (non-BMP) file into the *.BMP format, which
displays more quickly in SST.

· Choose Use Images Palette to opt to use the palette saved with this file instead of 
using the general default palette.    This produces a more accurate reproduction of the file
on the screen.    On the other hand, if several images are being shown at one time, using 
the default palette may be a better option, since it has an even mix of colors.



Image Actions

Image Actions are actions which can be assigned to an image element.    Click on the Action
icon    when an image element is selected to bring up a list of all image actions.
Move / Size - Use Move/Size to move the image to a new position on or off the slide or to 

resize the element.    The image element is placed in a new position or resized by 
manipulating the arrows in the media editor.    The element can also be dragged into a 
new position or resized by dragging on the pull squares around the bounding box.

Pause - Use Pause to pause before executing the next action in the Playlist for a set period 
of time or until specified key or mouse button is clicked.    A Pause Editor will be 
displayed.

Auto Record - Use Auto Record to switch to the automatic recording mode for defining 
actions. This mode streamlines the operation of defining a series of actions.    When Auto
Record is on any changes made to the attributes of the slide or element will be recorded
as a new action.    
The Action icon will flash when the Auto Record mode is on.    Auto Record can be 
initiated by choosing this option from any Action list or by selecting the Auto Record 
option from the Carousel menu.    To exit Auto Record, click on the Action icon or from 
the Carousel menu, deselect Auto Record by clicking on it.



Draw
Draw Description
Draw Attributes  
Draw Actions



Draw Description

Draw elements such as circles and lines can be used to create bullet points, 
underline key words or highlight an area of the screen.      As with text elements, use 
colors for draw elements which will complement the overall slide.    Avoid the 
temptation to make draw elements too busy and thus detract from the message.      



Draw Attributes
The Draw Editor is used define attributes for all draw elements.    Click on the Attributes 
list box of the Draw Editor to see these draw attribute choices. 
Shape - Use Shape to choose a shape for the draw element.    A Shape Editor will be 

displayed.
Fill Color - Use Fill Color to select a color to fill the inside area of a shape.    When the color 

editor is displayed, click on a color to select it.
Pen Color - Use Pen Color to select the color of a line or to select the perimeter color of 

other shapes.
Location / Size  - Use Location/Size to position the element on the slide or to resize the 

element.    A Location/Size Editor is displayed.
Frame Appearance - Use Frame Appearance to create a frame around the selected 

element.    A Frame Appearance Editor will be displayed.
Hot Spot - Use Hot Spot to define the area covered by the draw element as a hot spot for 

interactive branching or to trigger an event.    Click here to see an illustration of the Hot 
Spot Editor and a complete description of each choice.



Shape Editor

· Click on the radio box by a shape to select it.    
· Select the Transparent option to make the shape transparent (remove all color).    This 

is useful for creating an invisible hot spot.    
· Select Rotation to rotate the shape within the bounding box in a counterclockwise 

direction.    Enter number of degrees in the list box.



Draw Actions
Draw Actions are actions which can be assigned to a draw element.    Click on the Action 
icon when a draw element is selected or right click on the selected element to bring up this 
list of draw actions.    Then click on an action to select it.
Move / Size - Use Move/Size to move a draw element to a new position on or off the slide 

or to resize the element.    The element is moved or resized using the arrows in the editor.
An element can also be dragged to a new location or resized by pulling on one of the pull
squares around the bounding box.    

Fill Color Change - Use Fill Color Change to change the inside or fill color of a shape to a 
different color.    Click on the new color in the color editor to select it.

Pen Color Change - Use Pen Color Change to change the color of a line or the perimeter 
color of any other shape to a new color.

Shape Change - Use Shape Change to change the shape of the element to a different 
shape.

Pause - Use Pause to define a pause before executing the next action in the Playlist.    
Pause is set for a set period of time or until specified key or mouse button is clicked.    
See the Pause Editor for details.

Auto Record - Use Auto Record to switch to the automatic recording mode for defining 
actions. This mode streamlines the operation of defining a series of actions.    When Auto
Record is on any changes made to the attributes of the slide or element will be recorded
as a new action.    
The Action icon will flash when the Auto Record mode is on.    Auto Record can be 
initiated by choosing this option from any Action list or by selecting the Auto Record 
option from the Carousel menu.    To exit Auto Record, click on the Action icon or from 
the Carousel menu, deselect Auto Record by clicking on it.



Sound
Sound Description
Sound Attributes  
Sound Actions



Sound Description

Sound elements are used for background music, voice narration or sound effects.    
Two types of sound files can be used in an SST presentation, WAV or MIDI files.    WAV 
files are available as clip media or are created using a sound card.    They are typically
used for sound effects or voice narration.    To create a WAV file in SST, use the Record
attribute of a sound element.    Since MIDI files are synthesized sound instead of 
sampled digital audio like a WAV file, they are often used to provide background 
music.    An advantage of MIDI files is that they require far less disk space than WAV 
files.    MIDI and WAV files can be played together in SST, thus voice narration can be 
accompanied by background music if your sound card supports this capability.



Sound Attributes
The Sound Editor is used to select or test sound elements.    Click on the Attributes list box 
to view the following two attribute choices. 
Sound - Use Sound to verify, select or change a sound file.    Click here to see the Sound 

selection editor.
Record - Use Record to record or test a sound file.    Click here to see the Sound Recorder.



Sound Editor

The box at the top of the editor displays the name of the sound file if one has been selected. 
· Click on Clear to remove the selected file from the sound element.    
· Click on Select Sound to bring up a File Selection dialog box.    Choose List Files of 
Type to choose the *.WAV or *.MID format.    Use Drives and Directories to move to the 
correct subdirectory.    Click on Preview to listen to the highlighted sound file before 
selecting it.    Then double-click on the filename of the sound file to select it.



Sound Recorder

· Before recording set options for sampling rate (11, 22 or 44 kHz), resolution (8 or 16 
bit) and mode (mono or stereo). 
· Use Clear to clear the contents of the selected sound element.
· Use Open to bring up a File Selection box so that you can choose a file to open.
· Use Record to begin recording at the beginning of the file.    Previous contents will be
overwritten if you save the file.    
· Use Stop to stop recording.    A File Selection box will appear to allow you to save the 
file.
· Use Pause to pause during the middle of recording.    If Pause is selected the button 
changes to Resume.    Use Resume to resume recording at the point at which the pause 
was executed.    
· Use Play to listen to the contents of the file.



Sound Actions
Sound Actions are the actions which can be assigned to a sound element.    Unlike a sound 
file which is added to a file as a slide attribute, sound elements must be assigned a   Play   
Sound   action to begin playing  .    This feature allows you to synchronize sound with other 
actions occurring on the slide.    Click on the Action icon when a sound element is selected 
to bring up the list of sound actions.
Play Sound - Use Play Sound to play the sound file.    When the action is added to the 

Playlist it is assigned a default time.    This time is based on the length of the file.    Due to
differences in sound cards and drivers, this length of time will not be exact.    In some 
cases, it may be necessary to increase the amount of time in order to hear the entire file.

Pause - Use Pause to pause before executing the next action in the Playlist for a set period
of time of until a specified key or mouse button is clicked.    Click here to see the Pause 
Editor.

Auto Record - Use Auto Record to switch to the automatic recording mode for defining 
actions. This mode streamlines the operation of defining a series of actions.    When Auto
Record is on any changes made to the attributes of the slide or element will be recorded
as a new action.    
The Action icon will flash when the Auto Record mode is on.    Auto Record can be 
initiated by choosing this option from any Action list or by selecting the Auto Record 
option from the Carousel menu.    To exit Auto Record, click on the Action icon or from 
the Carousel menu, deselect Auto Record by clicking on it.



Movie
Movie Description
Movie Attributes  
Movie Actions



Movie Description

Movie elements can be animation or digital video files.    Animations range from 
simple object animation, like the movement of a text across the screen, to complex 
3D renderings.    Digital video is video which has been converted from an analog 
format and stored on the computer.    Because of the complex nature of animation or 
digital video files, they typically require considerable space on your hard drive.    They
are used in presentations to add excitement and to present complex visual 
information.



Movie Attributes
The Movie Editor is used to select or play video segments (movies).    There are four 
attribute selections in the editor.
Movie - Use Movie to check or select the movie file (FLC, FLI or AVI format) to associate 

with the current movie element.    Click here to see the Movie selection editor.
Controls - Use Controls to play the animation or video clip file.    The choices available in 

this editor are Play and Stop.
Location / Size - Use Location/Size to position the element on the slide or to resize the 

element.    A Location/Size Editor displays .
Frame Appearance - Use Frame Appearance to create a frame around the selected 

element.    A Frame Appearance Editor is displayed.



Movie Editor

· Use Clear to remove the selected movie file from the movie element so that a new 
choice can be made.
· Use Select Movie to bring up a File Selection dialog box.    Under List Files of Type,
select the *.FLC, *.FLI, or *.AVI file format.    Use Drives and Directories to move to the 
correct subdirectory.    Then double-click on the filename to select the file to be loaded.
· Select Load into Memory to load the entire animation file into memory before it 
plays.    This will allow the file to play more quickly after it begins.



Movie Actions
Movie Actions are the actions which can be assigned to a movie element.      Click on the 
Action icon when a movie element is selected to bring up a list of action choices.
Play - Use Play to play the animation or video clip file.
Move / Size - Use Move/Size to reposition or resize the movie element as it plays.    Move 

the movie to its new location or change its size using the arrows in the editor.    The 
element can also be dragged to a new location or resized using the pull squares around 
the bounding box.

Pause - Use Pause to pause before executing the next action in the action list.    A Media 
Editor for Pause will be presented.

Auto Record - Use Auto Record to switch to the automatic recording mode for defining 
actions. This mode streamlines the operation of defining a series of actions.    When Auto
Record is on any changes made to the attributes of the slide or element will be recorded
as a new action.    
The Action icon will flash when the Auto Record mode is on.    Auto Record can be 
initiated by choosing this option from any Action list or by selecting the Auto Record 
option from the Carousel menu.    To exit Auto Record, click on the Action icon or from 
the Carousel menu, deselect Auto Record by clicking on it.
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Carousel
A carousel is the basic structure on which SST presentations are built.    Carousels are 
made up of slides and can contain an entire presentation or be linked together to 
form a larger presentation. 



Slide
A slide is a segment of an SST presentation or carousel.    Each slide can be thought of
as a mini-movie.    A slide can have its own attributes and it may contain additional 
elements.



Element
An element is a media component which can be added to a slide.    It can be text, a 
graphic, an image, a sound or a movie.    Elements can have a variety of attributes 
and can take on actions.



Attribute
An attribute is a quality that a slide or a slide element can have. Possible attributes 
vary according to the type of media.    For example, font style is a text attribute, 
shape is a draw attribute. 



Action
An action is used to define a change in an element while a slide is being shown.    
Actions vary according to the type of media.    A move is an example of an image 
action, whereas play is an example of a sound action.



Asynchronous
Actions not occurring at the same time.



Synchronous
Synchronous means to occur concurrently. Synchronous actions are played together.



Action Playlist
The action playlist is a list of all actions defined for the current slide.    The playlist is 
automatically generated as actions are added - either using the Action icon or while 
in Auto Record mode.



Alignment Icons
The alignment icons are used to position media elements on the screen.



Edit Icons
The edit icons are used to cut, copy, paste or duplicate elements .



Element List
The element list is a list of all media elements on the current slide.    



Play Controls
The play controls allow you to play back or view the actions on the current slide as 
well as advance, reverse one slide at a time or jump to the beginning or end of a 
carousel.



Media Editor
The media editor is used to present attribute options for the selected media element.    The 
editor allows you to make selections, such as filename, shape or font style, which are used to 
define each element.    



Tile
The tile effect is used to fill an entire area with multiple copies of an image.



Use Image's Palette
The Use Image's Palette Option instructs SST to use the palette of the current image 
for the current slide.



Preview Window
The Preview Window is a work window in SST where the slides are created and 
modified in a quarter screen area.



Convert
The process of changing the file format to a different format. In SST, the Save as 
Bitmap feature of the Image Editor is used to convert images to the BMP file format.    
The BMP file format can be displayed more quickly than other file formats.



Bar Chart
A 2 dimensional chart style using bars to illustrate data.



2D Charts
Charts with a two dimensional aspect, such as bar, line and area charts.



3D Charts
Charts depicting trends based on two variables.    These charts have a three 
dimensional aspect.



Animation
A computer visual containing motion.    Animation formats vary according to the 
software used to create them.    The FLC and FLI formats are the standard supported 
by Autodesk™ products. 



ASCII
The American Standard Code for Information Interchange, a standard which assigns a
unique binary value to each text and control character.



Auto Record
An SST authoring mode in which all attribute changes are recorded as new actions 
automatically.



AVI
Audio Video Interleaved - a file format developed by Microsoft used to display video 
clips with audio in Windows.



Bitmap Image
An image saved in a format defined as an array of pixels or pattern of dots.



Channel
Defines the way in which audio is recorded, single channel (mono) or two channel 
(stereo).



Chart
An image used to illustrate data in a graphical format.



Windows Clipboard
A temporary storage area used to transfer data within or between applications.



File Format
The structure of information in a file, often identified by the file extension.



Font
A set of characters (letters, numbers, symbols, punctuation marks) which have a 
specific size and design.    The design itself is called a typeface.



Font Size
The size of a font, also known as point size, which is the height of a font in points.    A 
point is 1/72nd of an inch.



Gradient
A gradual blend of two colors.    Gradients may have different styles, which determine 
the direction or pattern of the blend.



Grid Lines or Dots
Lines or dots optionally displayed in the Preview Window to help align elements.



Hot Spot
An area of a slide which triggers an action when clicked on with a mouse.



Interactivity
The ability to branch or take some other action in a presentation based on user input.



Line Chart
A chart style using points to illustrate data and connecting the points with lines.



Master Slide
A slide selected to be used as the basis for any new slide added to a presentation.    
Master slides may include background images and sounds, as well as media elements
and actions.



MCI
Media Control Interface - a Windows standard for multimedia devices.



Menu Bar
Located near the top of the screen, the menu bar contains the names of available 
menu choices.    When clicked, a menu choice will bring up a list of available 
commands or options.



MIDI
Musical Instrument Digital Interface, an audio file standard providing instructions for 
hardware to play back sound at specified tones, volumes, tempos, and lengths.



Mono
Monophonic sound, recorded and played back on a single channel.



Pixel
A picture element, a single dot in a digital image.



Image Palette
The range of colors used to create a digital image.    This information is contained in 
the file itself.



Permanent Swap File
A reserved area of the hard disk used by Windows to temporarily place information in 
order to free memory.



Pie Charts
Charts used to illustrate parts of a whole.



Photo CD
A format for high resolution, photographic images.    Any roll of film can be converted 
to Photo CD files which can be displayed on the computer - which provides an 
economical alternative for creating digital images.



Resolution, Graphics
The quality level at which images are displayed - the number of pixels a monitor or 
video card can display expressed in two numbers (for columns and rows).    Higher 
resolutions produce better quality, but require more disk space.



Runtime Version
A version of an SST presentation which can be distributed (i.e. installed and run on 
another system which does not have SST).



Sample Rate
The rate at which audio data was sampled when recording a digital audio file.



Sample Resolution
The quality of each sound sample, 8-bit or 16-bit.    An 8-bit sample can have 256 
values, whereas a 16-bit sample can have 65,536 values.    Though 16-bit files will be 
of higher quality, they are twice as large.



Sampling
The means of creating a digital sound file from the analog format, by recording 
samples of the sound at regular intervals.



Sound Recorder
A tool used to record digital audio files for playback in a presentation.



Status Bar
The bar at the bottom of the screen used to identify areas of the SST interface as the 
mouse cursor passes over them.



Template
A design used for a chart, exclusive of data, which can be applied to other charts.



Thumbnail
A reduced view of a slide.



Transition
The effect used to move between two slides in a presentation.    Entrance and exit 
transitions can be defined.



TWAIN
A software specification designed to provide a uniform interface between software 
which supports graphics and image capture hardware, such as scanners and digital 
cameras.



Virtual Memory
Computer space utilized as memory, such as hard disk space, which is not RAM.



Wave Sound
A sampled sound file with a *.WAV extension.    This is the Windows digital audio 
standard and is typically used for voice files and sound effects.

 





Quick Help
For more information, click on any of the icons in the SST illustration shown below or choose 
from the list.

Action icon
Attributes
Edit icons
File icons
Media Editor
Media icon
Menu Bar
Placement icons
Play Controls
Playlist
Preview Window
Slide Element List
Sorter icon
Status Bar
Thumbnail sketches



Action icon
The Action icon is located directly beneath the slide Preview Window.    Clicking on the 
Action icon brings up a list of actions for the current (highlighted) element. 

To choose an action from the list, click on that action choice.    If an action is added, a 
description of that action will automatically be added to the Playlist.    A default time for 
each action is assigned.    Click anywhere outside the list of choices to remove the list 
without adding an action.



Edit icons
The Edit icons are removed or placed on the screen by clicking on Toolbar Buttons under 
the View menu.    The icons are displayed only if the option has a check mark in front of it.    

The Cut,  Copy, 
 Paste 
 and Duplicate 
 icons are used to edit a slide or slide element.    

Two options under the Edit menu, Clipboard and Scrap Buffer define the functions of 
these icons.    If Clipboard is selected, only the slide itself or text or image elements can be 
edited.    This edit mode is used to place the contents of the element on the Windows 
clipboard, where it can be accessed by other applications or transferred to another location 
in SST.    If Scrap Buffer is selected, the slide and all types of media can be edited.    In this 
mode, the element or slide with all its attributes is transferred.



Cut icon
If Clipboard is selected: 
· Click on Cut to remove the contents of the element and place it on the Windows 

Clipboard.    For example if a text element is selected, only the text -not the font style,
color or location - will be placed on the Clipboard. 

If Scrap Buffer is selected:
· Click on Cut to remove the element and its attributes and place them in the buffer.    

In this case if a text element is selected, the text, with its font style, color and all 
other attributes is placed in the buffer.



Copy icon
If Clipboard is selected: 
· Click on Copy to copy the contents of the highlighted element to the Clipboard. 
If Scrap Buffer is selected:
· Click on Copy to copy the element and its attributes into the buffer, while leaving the

original on the slide.



Paste icon
If Clipboard is selected: 
· Click on Paste to paste the contents of the Clipboard into the highlighted element. 
If Scrap Buffer is selected:
· Click on Paste to place the contents of the buffer on the slide.



Duplicate icon
Click on the Duplicate icon to copy the highlighted slide element and insert the copy
on the slide.    If the slide itself is being duplicated, the copy will be inserted after the 
current slide.



File icons
File icons are used to open, save or close a carousel.    The File icons are removed or placed 
on the screen by clicking on Toolbar Buttons under the View menu.    The icons are 
displayed only if the option has a check mark in front of it.    

Click on Open  to bring up a file selection box to choose a file to be opened.    

Click on Save  to save the contents of the current carousel.    

Click on Close  to close the current carousel file.



Media Editor
The Media Editor is the center left quarter of the screen.    Each time a new slide element is
selected, the Media Editor automatically changes to the appropriate editor for that type of 
media.    The basic SST interface remains the same, but the media editors vary.    A Media 
Type icon is displayed on the upper right of the editor to identify the type of Media Editor 
currently in use.

The Attributes list box is located at the top of the Media Editor.    It contains a list of 
attributes for the selected element. When an attribute is chosen, the lower part of the editor 
displays all available options for that attribute choice.    

For example, if you add a draw element, a graphic shape will be added to the slide.    The 
element can then be assigned a variety of attributes.    Attributes for draw media are: Shape,
Fill Color, Pen Color, Location/Size, Frame Appearance and Hot Spot.    If Fill Color is selected, 
a chart of available colors is presented.    Clicking on a color in the chart selects that color to 
fill the shape.       



Menu Bar
The menu bar contains the names of available menu choices.    When clicked, a menu 
choice will bring up a list of available commands or options.

For more information see File, Edit, Carousel, View, Run, Window, Tools, or Help.



Placement icons
The Placement icons are removed or placed on the screen by clicking on Toolbar Buttons 
under the View menu.    The icons are displayed only if the option has a check mark in front 
of it.

There are three types of Placement icons:    Align, Space and Size.    If you click on any of 
these placement options, a list of choices is presented.    

Align  can be used to position a single element or group of elements.    Alignment 
icons are used to position slide elements on the screen quickly, just as the align choices 
under the Edit menu do.    They can be used to move an element to its beginning position on
a slide or after a Move/Size action was selected to move the element to a new location.    
Simply click on the Align icon and then on the appropriate Alignment icon to move the 
element to the indicated location. 

Several elements can be aligned at one time.    To select several elements, hold down the 
SHIFT key while clicking on each element.    When multiple elements are selected, elements 
will not align to the edge of the screen, but will align with the last selected element 
(identified with solid pull squares).    For example, if left align is selected, the elements will 
be aligned to the left edge of the last selected element instead of to the left edge of the 
screen.    

Space  is used to adjust the spacing between elements.    It is only active when three 
or more elements are selected.    To create even spacing between elements, first select at 
least three elements.    Then click on Space and select either Even Vertical or Even 
Horizontal spacing. 

Size  is used to make elements equal in size to the last selected element.    That 
element is depicted with solid pull squares, while other selected elements have outlined pull 
squares.    When Size is selected, two choices are presented:    Equal Width or Equal 



Height. 



Preview Window
In the center right area of the screen, the current slide will be presented in quarter screen 
size.    Slide creation is simplified with this WYSIWYG (What You See Is What You Get) view of 
the slide.    As new elements are added to the slide they are illustrated in this slide Preview 
Window.    As attributes and actions are assigned to the elements, they are shown in the 
Preview Window.

The current slide and current carousel are identified in the box to the left of the band of 
thumbnail sketches. 



Slide Element List
The Slide Element List is a list of all media elements which have been added to a slide.    It 
is automatically generated.    Each time a new element is added to a slide, a line is added to 
the Slide Element List which states the type of media and a descriptive file name or 
phrase. 

To view the Slide Element List contents: 
· Click on the Slide Element List box.

When the Element List is closed, it displays only the name of the current element.    The 
current element is also highlighted in the list below.    An element can be selected by clicking
on it.    That item is then highlighted (appears in a bounding box with small pull squares at 
the outside corners and sides) in the Preview Window.

Elements are placed on the screen in layers as they are added to a slide.    Each layer 
overlaps preceding layers.    These layers can be reordered using the View menu options: 
Bring To Top, Bring Forward, Push Behind or Push To Bottom.    As items are reordered,
their positions on the element list will change.    

Note:    The Element List can be used to select an element which is to be modified or 
assigned an action.    This is necessary if the element has been moved outside the area 
visible in the slide Preview Window or if the element is a sound element and cannot be 
distinguished in the Preview Window from any other sound element. 



Sorter icon
To see a broader cross section of the carousel, click on the Sorter icon.    It is located above 
the carousel/slide identifier.    A new screen showing up to 23 slides will appear.    Not only 
does this screen provide a view of a wider cross section of the carousel, it also allows you to 
quickly reorder the slides.

To reorder slides using the autoscroll technique:
1. Click on the slide to be moved and drag it toward the direction indicated below:

Drag to this edge To scroll this direction
Top Backward in the carousel, one row of slides at a time
Right Forward one slide at a time
Left Backward one slide at a time
Bottom Forward one row of slide at a time

2. Drop the slide in its new position.



Thumbnail sketches
The thumbnail sketches of five slides are displayed above the status bar near the bottom of 
the screen.    The framed slide in the middle is a thumbnail sketch of the current slide.    The 
first two thumbnails are slides which precede the current slide in the current carousel.    The 
two thumbnails on the right follow the current slide. 

The ability to view thumbnail sketches of adjacent slides in a carousel speeds up the 
creation process.    At any time you can see not only what is being presented on the current 
slide, but how it fits into the overall presentation.    Slides can be repositioned in the carousel
simply by dragging the slide to a new slide location and dropping it.

 





Tutorials

 An Overview
 Quick Help for Interface
 Basic Techniques
 Menu Bar Commands
 Tutorials
    Quick Lesson 1 - Beginner
    Quick Lesson 2 - Intermediate
    Quick Lesson 3 - Advanced
 Troubleshooting

For Help on Help, Press F1



Quick Lesson 1 - Beginner
Quick lesson 1 will show how easily and quickly a presentation can be built.

This lesson may be printed, if you want a print out of Quick Lesson 1, choose Print 
Topic from the File Menu.

Introduction to the Background Slide:
The Background Slide can be thought of as a backdrop for your presentation.    To add 

a Background Slide to your presentation click the  button in the 
Media Editor.    This will bring a dialog to the screen for you to select an image.    
Select bgkgnd002.bmp for your Background Slide.

Notice that the Slide Element List has the name of the image for your Background Slide, the 
Preview Window now contains a reduced version of the Background Slide, and that there is a
small thumbnail sketch named Slide 1 near the bottom of the screen.    

Click the  on the Carousel Control to advance to the next slide.    Add another    
Background Slide named bluesst.bmp to your presentation.    You will see that this image is 
quite small and is in the center of the screen, to fill the screen with many of these images, 
select Tile from the Media Editor.    

To see the presentation you have created, perform the following steps:
Click the  on the Carousel Control to back up to the first slide in your 
Carousel.

Click the  on the Carousel Control to rewind the action playlist.
From the Run Menu select Full Screen (a  will appear to the left when selected) and 
unselect the option Play Single Slide.
Double-click the Current Slide Thumbnail.

Introduction to Background Sound:
Adding sound to your presentation is also very easy.    To add sound to the 
presentation you created above perform the following steps.    

Click the  on the Carousel Control to back up to the first slide in your 
Carousel.

Pull down the Attribute List above the Media Editor and select Sound.    You will notice that 
the Media Editor has now changed to an editor that is applicable to sound.

Click  to bring a dialog to the screen for selecting a sound file.    Choose the file
named jet.wav.

You have just added sound to your presentation!    To see and hear the 
presentation, rewind the action playlist and double-click the Current Slide 
Thumbnail.



Quick Lesson 2 - Intermediate
Quick lesson 2 will introduce actions and the Action Playlist.

This lesson may be printed, if you want a print out of Quick Lesson 2, choose Print 
Topic from the File Menu.

Introduction to the Actions in Slides:
Create a Text Element:

Click on the Media Icon .

Click on the Text Icon  then drag and drop the Text Element near the left edge of 
the screen.

Edit the text:
While the Text Element has the Bounding Box around it, make sure the 
Attribute is set to Text in the Media Editor.
Click in the large white area in the Media Editor that contains the words 
Default Text. 
Change the words to: Hello, and welcome to the world of Multimedia!

Resize the Bounding Box to make complete text visible:
Click and drag the center Pull Point, on the right edge of the Bounding Box, 
towards the left edge of the screen until the ! can be seen.

Move the Bounding Box to the lower right portion of the Preview Window:
Click anywhere inside the Bounding Box and drag it towards the lower right 
corner of the Preview Window.

Change the Attribute of the Media Editor to Alignment:
Click the Down Arrow for the Attributes and select Alignment.

Change to Right Align:
Select Right in the Media Editor.
Move the Bounding Box so that the words cannot be see on the screen but the
left edge of the Bounding Box is still visible.

Add a Move to the Text Object:
While the Bounding Box is still visible, Click the Action Icon .    A list of 
applicable actions will appear on the screen, select Move/Size.

Click and drag the Bounding Box to the lower left corner of the screen until the ! disappears.

To see what has been created, perform the following steps:
From the Run Menu select Full Screen (a  will appear to the left when 
selected) 

Click the  on the Carousel Control to rewind the action playlist.
Double-click the Current Slide Thumbnail.

If the words seem to go by too fast to read, the time for each action is easily 
adjusted.
Adjust the time for this action:

Click on the Expand Icon for the Action Playlist
Select the Move/Size Text action



Click on the number 2000 and change it to 10000.    This number is in 
milliseconds (10000 = 10 seconds).

Run the presentation to see what has changed:
Click the  on the Carousel Control to rewind the action playlist.

Double-click the Current Slide Thumbnail.

Add a circle to the screen:
Click on the Media Icon .

Click on the Draw Media Icon , drag and drop the element in the upper left corner 
of the Preview Window.
Change the Attribute of the Media Editor to Shape by clicking the attributes box.
Click on ellipse in the Media Editor.

Add a Move to the ellipse:
While the Bounding Box is around the ellipse, click the Action Icon , a list of 
applicable actions will appear on the screen.

Select Move/Size.
Drag and drop the ellipse near the bottom middle portion of the Preview Window.

Add another Move to the ellipse:
While the Bounding Box is around the ellipse, click the Action Icon , a list of 
applicable actions will appear on the screen.

Select Move/Size.
Drag and drop the ellipse near the top right portion of the Preview Window.

Run the presentation to see what has changed:
Click the  on the Carousel Control to rewind the action playlist.

Double-click the Current Slide Thumbnail.

Notice that the Synchronize Icons (located in the Action Playlist) looks like this .    
This means that these actions will happen one after the other.

Change the Actions to be Synchronized:
Click on the Expand Icon for the Action Playlist to expand the Action Playlist.
Click on all three of the Synchronize Icons (They will now look like this ).

Adjust the time for the Move Shape Actions to 5000 milliseconds each.

Congratulations!    You have successfully added action to a slide, run the presentation 
to see what has changed:

Click the  on the Carousel Control to rewind the action playlist.
Double-click the Current Slide Thumbnail.



Quick Lesson 3 - Advanced
Quick lesson 3 will introduce the more advanced features of    such as pause, wait for 
input and branching.

This lesson may be printed, if you want a print out of Quick Lesson 2, choose Print 
Topic from the File Menu.

In this tutorial, four slides will be created.    The first slide will be an interactive menu 
which will allow you to jump directly to any of the other slides.

Create four slides:
When Slide 1 is loaded, select the Background Color attribute of the slide 
editor.    Choose a green background for the slide. 
Advance the carousel to Slide 2.    Select a red background color for the slide.
Advance the carousel to Slide 3.    Select a white background color.
Advance the carousel to Slide 4.    Select a blue background color.

Move back to the first slide:
From the Carousel menu, choose Jump to Slide.
Double-click on Slide 1.

Change the exit options for Slide 1:
Choose the Exit attribute of the slide editor.
Deselect all exit options.    If a check appears by any of the last three options, 
remove the check by clicking on it.

Add a text element:
Click on Media, then Text to add a new text element and drag it to a point 1/4 
of the way from the top of the screen.
Edit the text to read:    "Choose a color:"
Adjust the size of the bounding box to accommodate all of the text if 
necessary.
Choose the Alignment attribute and select Center.

Add three more text elements:
Click on Media, then Text 3 times to add 3 more text elements.
Position these elements under the first text element in one column.
Edit the text elements to read:    "Red", "White" and "Blue" respectively.

Take the following steps for each of the last 3 elements:
Choose the Background Mode attribute and select Opaque.
Choose the Background Color attribute and select White.
Choose the Alignment attribute and select Center.
Drag the element directly to the left until it is not visible.

Assign a move to the "Red" text element:
Click on the element list and select the "Red" text element when the list 
appears.
Click on the Action icon and select Move/Size.
Click on the horizontal center icon (2nd from right) to center the text 
horizontally on the screen with this move.
Edit the time setting for this move to 1.    (To edit time, position the cursor over
the time display on the action list.    Click the mouse when the cursor changes 
shape and enter the correct time.) 



Click on the Action icon and select Pause.
Edit the time setting for this pause action to 1000.

Now the "Red" text element will pop on the screen, then a 1 second pause will occur 
before any other action.

Assign a move to the "White" text element:
Click on the element list and select the "White" text element when the list 
appears.
Click on the Action icon and select Move/Size.
Click on the horizontal center icon to center the text horizontally on the screen
with this move.
Edit the time setting for this move to 1.    
Click on the Action icon and select Pause.
Edit the time setting for this pause action to 1000.

Assign a move to the "Blue" text element:
Click on the element list to bring it up and select the "Blue" text element.
Click on the Action icon and select Move/Size.
Click on the horizontal center icon to center the text element with this move.
Edit the time setting for this move to 1.

Check the escape options, before running the carousel:
From the Carousel menu, select Play Options.
Check the setting for Exit Presentation Key and select Escape if it is not 
already selected.
Under Carousel Presentation Mode, select Replay Carousel When Last 
Slide Finished.
Click on OK to exit from the Play Options dialog box.

View the first slide:
From the Run Menu, select Play Single Slide.
Double-click on the small thumbnail sketch of slide 1 to view the actions 
assigned to this slide.

Assign hot spots:
Click on the "Red" text element to select it.
Click on the Hot Spot attribute and choose Jump to Slide.
When the dialog box appears, double-click on Slide 2.
Click on the "White" text element to select it.
Click on the Hot Spot attribute and choose Jump to Slide.
When the dialog box appears, double-click on Slide 3.
Click on the "Blue" text element to select it.
Click on the Hot Spot attribute and choose Jump to Slide.
When the dialog box appears, double-click on Slide 4.

Play the example:
From the Run Menu, deselect Play Single Slide.
Double-click on the small thumbnail sketch of slide 1 to view the carousel.

The first slide is displayed.    Since no exit conditions were defined, Slide 1 remains on
screen until a hot spot selection is made.    When a selection is made, a jump or 
branch is immediately made to the slide assigned to the hot spot definition.    
For example if "White" is selected, Slide 3, the White slide, will be shown immediately.
Any slides which follow the selected slide, will then be shown in order, until Slide 1 
reappears.

Press Escape to exit.



Another branching technique might be to return immediately to Slide 1 after each 
slide is shown.

Take the following steps on Slide 2, Slide 3 and Slide 4 to set up this branching 
structure:

Select the Exit option from the slide attribute list.
Click on Select Next Slide.
When the dialog box appears, double-click on Slide 1.    

View the carousel once again.
Double-click on the small thumbnail sketch of Slide 1 to view the carousel.
Press Escape to exit when you have finished testing the carousel.

This tutorial focused on branching techniques used to create an interactive carousel.   
If you have taken the three tutorials provided with the help system, you have been 
introduced to most of the basic techniques used in creating SST presentations.    If 
you would like to try more examples refer to the tutorial included the SST manual.

 



General Troubleshooting
If SST does not open after a successful installation, the problem may be outdated video 
drivers.    To determine if outdated video drivers are causing a problem, first try to run SST in 
regular VGA mode.

To run SST in VGA mode:
1. Click on Windows Setup in the Main program group.

2. Choose Options, then System Settings.    After noting the current setting, change the setting to 
VGA.    Restart Windows when prompted.    

3.    If SST opens in regular VGA mode, you should contact your video card manufacturer for new 
drivers.    When new drivers are installed, use System Settings again to reinstall video drivers.    
This will allow you to run SST with your previous system settings    OR

4. If you still have problems, reinstall SST.

If the carousel is large and starts to run slowly:
1.    Increase the size of your Permanent Swap File.

2.    Use the Unload Files feature found under Play Options in the Carousel menu.    This feature 
unloads files from memory after they have played, thus freeing memory for other uses.

If the SST program manager group does not display after installation:
· If you have a large number of program goups, delete the program groups of any programs not 

currently being used.    There is a limited amount of space for displaying program groups in 
Windows.    Deleting or combining some groups will create more space.    Then reinstall SST. 



Audio Problems
To determine why sound does not play in SST:
1. If it is a sound element, make sure a Play action is assigned to it.    See Sound Actions.

2. Attempt to play the file using the Media Player in the Accessories group.    If a sound file plays in 
the Media Player, it will play in SST.

If the file does not play in the Media Player, verify that audio drivers are installed.    From the 
Control Panel, select Drivers.    Look for MCI Sound drivers and drivers specific to your audio 
card.    If drivers are installed, check with the audio card manufacturer for updated Windows 
drivers.    If you do not have an audio card, check the PC speaker drivers.      

To prevent an audio file from cutting off while playing:
· Increase the time setting for the Play action by 100-200 milliseconds.    If your processor speed is 

slow or several actions are being processed, playback of the audio file may not be completed in 
the default time setting.    Increasing the time over which the action will occur should resolve the 
problem.    

It is also advisable to set the memory available for buffering audio data to the maximum allowed 
(nine seconds).    The Windows default setting is four seconds.    

To increase the memory available for buffering audio data: 
1. Choose the Control Panel icon from the Main program group.    Then choose the Drivers icon.    

2. Select MCI Sound and choose Setup.    When the dialog box appears, set the memory to the 
maximum setting of nine seconds.



Image Display Questions
To display images more quickly: 
·    Remember, larger files take longer to load.    Thus files with a high resolution and/or large number 

of colors will take longer to load.    If the load time is unacceptable, convert the file to a lower 
resolution.

· If the image is a slide attribute, do not use an entrance transition when presenting the slide.    

· If it is an image element which is being scaled, display time will increase.    Use an image 
conversion utility to create a new file if necessary.

· Use BMP or DIB files.    Since these are the native Windows formats, they are the preferred image
file formats for SST and display the most quickly.    Images can be converted to the BMP format 
from within SST.    To do so, use the option to Save as Bitmap... from the Image Editor.    Both 
image elements and image slide attributes can be converted.

· A Windows accelerator or VESA local bus video card will also improve the speed with which 
images can be displayed.

When displaying images while running in a 256 color mode, a bright flash of color 
may appear as a new image is brought to the screen.    This occurs if the images use 
different color palettes and the option to Use Images Palette is on.    The flash is 
actually the old image shown briefly with the color palette of the image about to 
appear.    Since this flash is distracting, SST has an option to change the screen to 
black between slides.    
To eliminate a palette flash between slides:
· Check to make sure that the option to Disable Auto-blacking is not selected.    To do so, choose 

Play Options from the Carousel.    If a check    appears in the box in front of Disable Auto-
blacking, click on the box to remove the check and deselect the option.    

Auto-blacking between slides is the default mode.    The option to Disable Auto-blacking is 
available because the transition to black is sometimes inappropriate or awkward.    If an image 
displays, but is distorted in some way, the problem may be related to the palette or resolution 
used to display the image.      

To display an image with the correct palette:
· Select the option to Use Images Palette from the Image attribute editor.

To determine the resolution and color mode of the image:
1. Open the image file in Windows Paintbrush.    Highlight a file name and click on Info.    A dialog 

box with resolution and color mode information is presented.

2. Verify that the image is saved in the same mode or lower as the mode in which you are running 
Windows.    That will be the optimum mode for displaying the image in SST.



Error Messages
To troubleshoot a General Protection Fault: 
· If you receive a Windows error message, such as a General Protection Fault, while working in 

SST, it is possible that there is a problem handling memory or in swapping information to and 
from the Permanent Swap File.    Thus, some of the memory area may be corrupt or the 
Permanent Swap File may be fragmented.    To correct either problem, exit SST and Windows 
then reboot your computer.

Problems may also occur if the Permanent Swap File is on a compressed drive.    For smoother 
operation, create a Permanent Swap File on an uncompressed drive.

To correct a General Protection Fault in anydevice.DRV: 
· If you receive an error regarding a *.DRV file, check with the vendor supplying the *.DRV files in 

question to see if they have an updated version.    This error indicates a conflict in Windows with 
the device driver for anydevice, where anydevice is hardware installed on your system and the 
device driver is the software which handles that device.    A typical conflict would result from 
outdated drivers for an audio card.

If you receive the message:    Couldnt find AAPLAY.DLL:

AAPLAY.DLL is a Dynamic Linked Library which allows you to display *.FLC or *.FLI 
files, the Autodesk™ format.    If this file is not found, SST will not run.    The 
installation program places AAPLAY.DLL on the local Windows System directory.    
Sometimes, if you are running Windows on a network, the location of this file is 
different.    In this case, you should take the following steps:
1. Find AAPLAY.DLL and AAVGA.DLL on the local hard drive in the Windows System directory.

2. As a temporary solution, copy these files to the directory where SST is installed.

3. As a permanent solution, ask the system administrator to place these files in the proper drive on 
the network (usually the Windows System directory).



Technical Support
There are a variety of sources of help available when using SST.    Your first option is 
to refer to the manual or to the online help.    Online help is accessed by clicking on 
the Help menu name, then choosing Index.

Technical support for SST is available from Monday through Friday from 8 a.m. to 6 
p.m. CST.    The telephone number is 1-612-531-0603.      The high priority FAX line is 
612-531-0645. 

The technical support BBS number is 612-531-0702 (9600 bps, 8, 1, N).    Contact 
technical support via CompuServe at address 73204,271.

 




